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As an educator, school leader, faculty member, or dean, you’ve got a lot on your plate. If you’re finding it a 
challenge to integrate creativity and digital literacy into your courses, you’re certainly not alone.

Adobe is here to help with a set of kickstarters you can use to inspire your students’ creativity, critical thinking, 
creative problem solving, and collaboration in any class. In these hands-on projects, your students will create 

images, graphics, videos, and other digital media as they explore texts, interpret source material, explain 
complex concepts, and more.

Explore these kickstarters to engage your students while improving their learning outcomes.
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CREATIVE COMMUNICATION WITH

DOWNLOAD A CHARACTER
Go to headsofcurriculum.com and download a pre-made character. This will give you 
a puppet file that you can use to get started. For future projects, your students may 
want to create their own custom characters, but let’s start with the basics for now.

IMPORT YOUR CHARACTER
In Adobe Character Animator, click New Project in the top left, then save your project 
file. Hit File/Import and select your puppet—it should then appear in the project panel. 
Next, drag the puppet down to the timeline at the bottom of the screen.

SET THE SCENE
If you have a webcam connected, you should be able to see yourself in the top right—
notice that the character follows your movements! To align everything, simply adopt a 
neutral, front-facing pose in the webcam view and press the Set Rest Pose button. Next, 
import a relevant image (repeat step 2), and add it to your timeline, making sure to 
place it underneath the character on the timeline so it doesn’t obscure them.

RECORD A VOICEOVER
Get yourself centered in your webcam and hit the red record button to start recording 
a take. All you have to do is speak as if you’re appearing on the screen explaining a 
concept, but the puppet will be doing all the work! Remember, you can delete takes you 
don’t like, and move the timeline slider back to the beginning to set up a new recording.

EXPORT AND SHARE
When you’re happy with your video, hit File/Export/Video via Adobe Media Encoder, 
then choose a location. When Media Encoder opens, simply hit the green play button, 
which will create a shareable mp4 file containing your video, ready for sharing.
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In this project, students build storytelling and communication skills 
by creating, animating, and giving voice to unique digital characters. 

In-app tutorials

Character Animator comes with a full set of 
user support in the form of in-app tutorials and 
online help. Get valuable information and tips 
on recording, arming, staging, and editing your 
scenes, including adding backgrounds and 
controlling the camera view.

Heads of Curriculum

Heads of Curriculum is a website offering 
educators a one-stop shop for everything 
needed to get started with Character Animator. 
There are beautifully crafted puppets such as 
Einstein, Queen Elizabeth I, and Goethe, 
all available for free.

Project Ideas
• �Puppet shows for creative

writing classes.

• �Biography presentations
for social studies classes.

• �Student-led lectures for math
or science classes.

Creative kickstarters for any class

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

http://headsofcurriculum.com
http://edex.adobe.com
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DEVELOP A SUBJECT-RELEVANT PODCAST WITH

LEARN
Students focus on choosing a contemporary topic expert to interview. To 
prepare for the interview, they examine the topic background information 
and identify interview goals. They also learn what makes a great podcast 
interview before writing their own interview questions.

EVALUATE
Students evaluate questions to create a guide for their podcast interview. 
They use the five Ws and one H (who, what, when, where, why, and how) 
to generate questions that identify knowledge gaps or consistencies with 
the expert interviewee. Questions may include: Who are you and what do 
you do? Why is this topic relevant to your expertise? What is your unique 
perspective with this topic? What is the single point you would like a 
listener to understand from this podcast interview?

CREATE
Using a cell phone or audio recording gear, students record the expert 
interview and then use Adobe Audition to edit it. They focus on editing the 
interview’s main points while editing out any unnecessary dialog or noise. 
Access to step-by-step help for using Adobe Audition can be found in the 
full resource linked below.

SHARE
Students share their finished recorded interview as instructed.
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In this project, students interview a subject matter expert 
and edit the audio for meaning-making. It contributes to the 
students’ body of knowledge of a particular subject area 
through multimodality.

Add all files into the interview track by simply dragging 
them or by importing and dragging them into the 
Audition timeline for editing. 

Add audio files

Project Ideas
 • �Use this project as a means for 

students to learn about careers 
they may wish to pursue.

 • �This project can stand on its 
own or be one component of a 
multi-part research project where 
students also produce written 
research.

Start a new project

Open Adobe Audition. Select “Template” > “Podcast.” 
In Audition, go to “File”> “new” > “multitrack session.”

Adobe Audition

Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Creative kickstarters for any class

https://edex.adobe.com/resource/MQX0EE7I6
http://edex.adobe.com
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BUILDING CREATIVITY AND RESEARCH SKILLS WITH

RESEARCH
Students research a geographic location to learn about physical characteristics, 
history, and connection to a historical event(s). You may choose to identify 
locations for them ahead of time to connect this strategy to a specific location, 
era of study, or event. During this step, students will develop a detailed 
description of the location and research what historical event(s) and people 
are associated with it.

PLAN AND DESIGN
Students plan and design the layout for their augmented reality (AR) tour to 
capture and share their understanding of the location and related event(s) 
researched in step one. 

CREATE
Students create the AR experience. This includes a digital or analog image 
that will act as the ground floor of their experience, supplementary images to 
be placed on the ground floor image to enhance the experience, audio files 
to explain the significance of the images, and text markers to guide visitors 
through the experience. Access to step-by-step help with Aero can be found 
in the full resource linked below.

SHARE
Students share and publish their AR experience as instructed with a link that 
peers or guests with an iPad can use to explore the experience.
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In this project, students illustrate their knowledge about a 
geographic location. Then, they play “virtual tour guide” for 
their peers using Adobe Aero on the iPad.

Select the image from the camera roll that will act 
as the ground floor of the experience by selecting 
“+” > “Camera Roll.” Rotate the image until it is 
parallel to the floor.

Add content

Project Ideas
 • �Each student chooses a different 

battle site from a war your class 
is studying.

 • �Each student selects a different 
state capital as the site for their 
augmented reality tour.

Start

G

Using an iPad, open Adobe Aero and select 
“Create New” (labeled G).

Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Creative kickstarters for any class

https://edex.adobe.com/resource/e2fh14eEz
http://edex.adobe.com
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EXPLAINING COMPLEX CONCEPTS WITH

GATHER INFORMATION
Ask your students to collect information about their project topic. Once they have 
gathered enough details and context, have them start sketching out some ideas 
for how they might represent these facts visually.

START CREATING
Once their initial ideas are sketched out, get your students to open Adobe Illustrator 
and create a new project by hitting Create New. For sizing, we recommend clicking 
on the Web tab on the window that appears and selecting Web-Large. 

BUILDING SHAPES
As an example, use the Ellipse tool to create some circles to represent scientific 
concepts or events on a timeline. To combine simple shapes into new ones, go to 
the Window menu at top of the screen and select Pathfinder. Select two or more 
overlapping shapes and hit one of the buttons on the Pathfinder tab to experiment. 
Don’t forget you can reverse any decision by hitting Ctrl+Z (Cmd+Z on Mac).

ADD YOUR INFORMATION
Try to find engaging ways to present your facts. Perhaps the simplest way to include 
written information is to add captions to your images using the Type tool. Maybe even 
experiment with the Type on a Path tool to get your text running around the outside 
of your shapes.

EXPORT AND SHARE
When you’re happy with your design or infographic, hit File > Export > Export for 
Screens, then choose a location to save your work to and hit Export Artboard. By 
default, this will create a PNG file of your project that you can share and add to 
presentations, web pages, and more.
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In this project, students use visual design to break down complex ideas, 
understand them better, and explain them more effectively.

Grids and rulers

Designing in Illustrator is much easier with guides, 
grids, and rulers. They are invaluable in keeping 
your graphics aligned and logically placed, perfect 
for creating and linking shapes together in this 
exercise!

Shape tools

Shape tools are located in the Tools panel. 
To show other shape tools, click and hold the 
Rectangle tool in the Tools panel. When you 
draw shapes, Smart Guides (View> Smart 
Guides) help by showing the shape size 
and snapping to other objects.

Project Ideas
 • �Simple graphics and text that map 

out a timeline, like key events in 
a war, for history classes.

 • �Illustrations of processes like cell 
division or terminal velocity for 
science classes.

 • �Infographics showing the elements 
of plot and story for language 
arts classes.

Creative kickstarters for any class

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

http://edex.adobe.com
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CREATING A WEB PAGE WITH

LEARN
Students watch a 5-minute Khan Academy Pixar in a Box video about the 
role of color in visual storytelling, learning about different color palettes’ 
psychological influences on mood. The film covers cool blues and greens, 
warm reds and oranges, and romantic pinks and purples. Students also 
review a student sample created from this project to help them gain a 
better understanding of the possibilities. 

CREATE
Each student chooses a single photograph as the basis for their project. 
They manipulate it in Adobe Creative Cloud Express with three different color 
filters, following the instructions in a step-by-step tutorial included in the 
project overview, found in the full resource linked below. They then write a 
50-to 100-word story starter for each of the three image variations.

SHARE
Students publish their pages using Creative Cloud Express and share as 
instructed. This project can be extended by having the students answer 
reflection questions at the end of their Creative Cloud Express web page—
explaining which of their three story beginnings is their favorite and why, 
and/or describing how photographers and writers can manipulate tone 
and mood in their work.
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In this project, students discover how the effects of changing 
the color of a single image creates different moods. They write 
brief story starters to accompany each image variation.

Open Adobe Creative Cloud Express and create 
a new Web page. Upload your three photos. 

Publish

Project Ideas
 • �Students choose one of their 

own personal photos to use 
for the project.

 • �Students take their favorite of 
their three story starters and 
develop it into a complete 
short story.

Create

Once you’ve chosen your photo, now 
you can apply filters.

Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Creative kickstarters for any class

https://edex.adobe.com/resource/v7764480b
http://edex.adobe.com
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CREATIVE VISUALIZATION WITH

In this project, students learn to convey a mood, express an idea, 
and illustrate a concept including techniques like blending to 
let them tell stories in powerful, visual ways.

Using blend modes

Blend modes change the way that a layer reacts 
with the layer underneath it. There are six main 
categories: Normal, Darken, Lighten, Contrast, 
Comparative, and Color. Experiment with them 
to find out how to blend layers to achieve 
creative effects in composite images.

Clipping masks

The text in the image shows a clipping mask 
in action. The colorful liquid texture image is 
placed on the layer directly above the slab text. 
Right-clicking and selecting “Create Clipping Mask” 
instantly fills the text shape with the layer above. 
The shape of the text has become the mask!

Project Ideas
 • �Digital collages representing key 

moments in a historical period 
for social studies classes.

 • �Simple GIF animations showing 
chemical or biological processes 
for science classes.

 • �Image representations to help 
visualize vocabulary words in 
language arts classes.

Creative kickstarters for any class
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PLACE YOUR LAYERS
First, download these image assets. In Photoshop, open the image of the young 
woman, then use the File > Place Embedded command to add two more texture 
layers on top of the background image. Use the pick-up handles to scale the 
textures over the top of the whole image.

APPLY BLEND MODES
Choose the texture image layers and experiment with the blend mode options 
available in the layers panel. You will see how the layers interact with the background 
image and choose whichever ones achieve the aesthetic effect you are after. 
TIP: You can use the eraser tool to “cut through” the layers to reveal the background. 
(See the eye example on the right).

MAKE A SELECTION
Use File > Place Embedded to add the guitar image. Press “W” to start quick selection 
and select the background behind the guitar. Hit DEL to remove the background 
(and press “V” to return to Move tool). Position your guitar to the right of the screen.

ADD A CLIPPING MASK
Place another texture layer in the layer directly above the guitar. Right-click and select 
“Create Clipping Mask”. The texture should automatically fit inside and overlay onto 
the guitar image. See example on the right.

ADJUST IMAGE
Finally, we can make adjustments to the color of layers like the guitar, or we may 
want to enhance the color of some of the texture layers to create different effects. 
For the blue guitar, select Image > Adjustments > Hue/ Saturation and move the 
sliders to change the color of the guitar. Once your image is complete, File > Save 
As and select JPG as your file format.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

https://jpeclients.com/Adobe/Photoshop/
http://edex.adobe.com
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EXPLORING TEXTS WITH

NAVIGATE PAGES
First, download these assets and open the InDesign file “Macbeth”. When you see the 
file appear in the workspace, go to the panels on the right and select the page tab. 
Double click on page 2 of the document to open up that page spread.

USE FRAMES FOR LAYOUT
Building a layout is easy with frames. Frames show where content will eventually be 
placed. Press (F) to switch to the Rectangle Frame tool and draw a rectangular frame 
in the orange space at the top of page 2 that aligns with the guides on the page. 
Press (V) and click on the frame. Go to File > Place and select the “Blood” image. 
The image should place inside the frame.

CONNECT TEXT FRAMES
lnDesign helps students control the flow of their text from column to column. Look 
at the text frame on the bottom left of page 2. There is too much text to fit that box 
(we know this because the bottom right of the frame has a red plus sign). Clicking on 
this plus sign will “load up” the remaining text so you can draw a text frame to the 
right of the original and it will flow text between the columns.

ADD A DROP CAP
Create a cool-looking Drop Cap on page 2! Highlight the first letter “L” of Lorem in the 
left text frame. In Paragraph Properties panel, find the “Drop Cap Number of Lines” icon 
(hovering your mouse over an icon will reveal a tool tip). Change the value from 0 to 5 
and you will have created a large drop cap at the beginning of your text on page 2.

USE STYLES
For your last step, in the panels, select Paragraph Styles > Article Text and click on the 
pencil icon next to it to edit the Paragraph Style. In Character Style Options, change the 
Character Color to [Paper] and your page should update with the new style change.
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In this project, students learn to create, interpret, and publish written 
content for different purposes so they can build their comprehension 
and communication skills.

Guides and Frames

Guides and Frames help you to layout a page to 
get the design you want before you start adding 
text and images. Students can use this to plan and 
design how to best organize information for their 
audience. For instance, when creating a newspaper 
article, students can choose the number of 
columns and size of the headline.

The Pages Panel

The Page Panel controls the number of pages 
in your files. Here you can swap pages around, 
add master pages to individual spreads, remove 
or duplicate pages within the document.

Project Ideas
 • �Interactive PDFs containing 

research and analysis for 
science classes.

 • �Flyers or brochures delivering 
persuasive arguments for English 
or social studies classes.

 • �Detailed glossaries of vocabulary 
words for language classes.

Creative kickstarters for any class

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

https://jpeclients.com/Adobe/InDesign/
http://edex.adobe.com
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BUILDING FIGURATIVE LANGUAGE SKILLS WITH

LEARN
Students learn what a metaphor is—and isn’t. They’re taught the difference 
between a metaphor and a simile, and shown how to identify and analyze 
a metaphor.

EVALUATE
Each student selects a song from a provided list of song options, found in 
the full resource linked below. 

Note: If you wish to allow students to search for and choose their own songs, 
consider reviewing and approving their choices before they begin the next 
step of the project to ensure subject and language appropriateness.

CREATE
Students upload their song lyrics as a PDF to Adobe Acrobat. Then they use 
the highlight and annotation tools to identify and analyze metaphors within 
the song. They look for the comparison of things that are not literally true. 
Using the relationship of the items compared, they make an inference about 
what the lyric is trying to convey. 

SHARE
Students share their PDFs as instructed.
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In “Musical metaphors,” students annotate song lyrics using 
Adobe Acrobat. The use of Acrobat empowers students to 
be active learners and demonstrate their understanding of 
metaphors in deep and meaningful ways.

Select the highlight tool to highlight metaphors.

Use the comment feature by clicking on the highlight. 
Write your analysis of the metaphor from the lyrics.

Highlight

Comment

Project Ideas
 • �Adapt this lesson for other types 

of figurative language.

 • �Extend the project by having 
students create a presentation  
of their findings in Adobe 
Creative Cloud Express.

Open

Open the PDF in Acrobat by selecting “Create” > “PDF 
from file” and selecting your saved PDF.

Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Creative kickstarters for any class

https://edex.adobe.com/resource/njpOJ1QFb
http://edex.adobe.com
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CREATING POETRY WITH

LEARN
Explain that prose relies on extended wording to convey meaning, but some 
forms of poetry use carefully chosen words that stimulate our senses. Provide 
examples of such poems to students for reference. Students use the selected 
text to choose words or short phrases that evoke emotion. The full project 
resource linked below uses Kate Chopin’s “The Story of an Hour,” but you can 
replace it with any text. The completed poems can be connected to the prose 
text or free form.

EVALUATE
If you’re asking students to remix prose text into a poem with similar meaning, 
allow them time to interpret the original text. If your focus is only on locating 
figurative language, you may skip this step.

CREATE
Students use highlighting and drawing tools in Acrobat to draw attention to 
words and short phrases. The project resource linked below provides steps to 
guide them, as well as an example and access to an Acrobat tutorial. One of 
the best things about annotating digitally is that students can make changes as 
they go. Acrobat allows them to erase, remove highlights, change colors, and 
make many other adjustments at any time.

SHARE
Students share and publish their finished poems as instructed.

1

In “Poetry starts with words,” students identify and interpret 
figurative language and devices in poetry by creating their own 
poetry in Adobe Acrobat. Using Acrobat encourages students to 
move beyond passively reading by engaging with language.

If you are using a tablet to complete this activity, note 
that your tools may be located elsewhere. Look for 
the “Comment” icon to access your toolbar.

Find Comment tools on a tablet

Open the Comment toolbar

With your document open, select the “Comment” 
toolbar. If you do not see Comment on your list 
of tools, select “More Tools” to locate it.
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Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Project Ideas
 • �This project can be adapted for 

nearly any text or language.

 • �This project is accessible on 
multiple devices, including 
desktop or laptop computers, 
tablets, and smart phones.

Creative kickstarters for any class

https://edex.adobe.com/resource/aiWM8do6d
http://edex.adobe.com
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DEEPENING UNDERSTANDING OF HISTORICAL TEXTS WITH

READ
Students read a historical article related to the current unit of study. You may 
choose to assign specific articles or allow your students to select their own.

ANNOTATE
Referencing a historical reading skills chart, found in the full resource at the 
link below, students use Acrobat to add annotations to their article. These 
annotations are intended to demonstrate their understanding and analysis of 
sourcing, contextualizing, corroborating, and close reading. Because the goal 
is to spark a silent conversation, annotations should be framed in a way that 
will encourage thought and discussion by peers.

CONVERSE
Students exchange links to their annotated PDF with assigned peers. Peers 
read and respond within the annotations, explaining whether they agree or 
disagree with the original annotator and why. Article links are then shared 
again until at least four classmates have annotated each article.

SHARE
After receiving their annotated article back, students review all of their peers’ 
annotations. Students create a final annotation, responding to the prompt, 
“I now have a better understanding of…” and share the document as 
instructed.

In this lesson, students engage in a silent conversation by creating 
annotations on a historical article in Adobe Acrobat, then sharing 
with a group of peers, who add to the conversation by creating 
their own annotations.

Select the “T” tool to add a text box with 
your thoughts.

Add text

Create annotations

Select the pencil button to create annotations. 
You can change the color by selecting the 
round color at right.

Share

When finished, click the share button 
and share a link with your peer, or with 
your instructor when complete.
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Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Project Ideas
 • �Extend this lesson with 

a discussion on historical 
context.

 • �Ask students to consider how 
today’s current events might 
be viewed by future historians.

Creative kickstarters for any class

https://edex.adobe.com/resource/ZCLxvnjne
http://edex.adobe.com
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ENCOURAGING ASSOCIATIVE THINKING WITH

LEARN
The travel destination may be assigned by the instructor or selected by students. 
Reading about travel, and traveling itself, are two different experiences. Students 
use the descriptions of place in travel writing to create their own “reality of an 
unknown place.” The objective is for them to identify how travel writers help 
readers gain a sense of a new place.

EVALUATE
Students closely read travel literature associated with the location. They choose 
three to five readings they can synthesize around a focused topic. If any of their 
sources are from printed books or magazines, have them use the Adobe Scan 
app on a mobile device to create a PDF from the printed material. See how 
easy it is in this 60-second video. As they read, they use the comment tools 
in Acrobat to add notes about images that come to mind.

CREATE
Students assemble a collection of three to five images related to the 
“experience of place.” They’re also guided on specific expectations for crafting 
an introductory essay. Remind students to use appropriately licensed images 
and citations. Suggest that they think imaginatively rather than literally.

SHARE
Students share and publish their completed document. You may wish to have 
them share with small groups or present their completed work to the class.

In “Tell a travel story with Acrobat,” students design and build an 
interactive PDF that tells a story about travel to evoke a sense of 
that place.

Choose “Add Files” from either the drop-down menu 
at the top of the screen or the button in the center 
of the screen. Note that the drop-down menu offers 
additional options from where you are retrieving files, 
such as directly from a scanner or web page.

Add files

Start

To start a new 
project: Open 
Adobe Acrobat > 
“Tools tab” > 
“Combine Files.”
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Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Project Ideas
 • �This project can be used with 

Adobe InDesign for students who 
are ready for more complex tools.

 • �For less technical complexity, 
students can also use Adobe 
Creative Cloud Express.

Creative kickstarters for any class

https://www.youtube.com/watch?v=K1h6wBRqDZQ
https://edex.adobe.com/resource/6j0k0NM2_
http://edex.adobe.com
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CREATING A BOOK PITCH WITH

REFLECT
Students analyze their completed written works, reflecting on their areas of 
strength and weakness, and select a collection of at least three pieces they 
feel demonstrates their best writing. They write a draft project proposal that 
explains to prospective agents why they’re worth the risk and how the selected 
works reflect their writing skills as a whole. Students can refer to a proposal 
template, found in the full resource linked below, for guidance.

DRAFT
Keeping in mind the type of writing they have selected to showcase and the 
type of proposal they’ll be making, students draft a resume to highlight the work 
experiences and skills that align to their proposal. A library of resume templates 
is available for students to select from among to best suit the audience and 
purpose of this assignment, or they may create their own resume design.

CREATE
Students create their Adobe Portfolio, which includes their project proposal, 
resume, and collection of written work samples. 

SHARE
Students share and publish their portfolios as instructed.
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Students create an Adobe Portfolio to showcase their written 
work, hoping to be selected by a fictional agent for a book project. 
In addition to curating self-selected works of fiction, students also 
create a resume and write a project proposal.

Finalize and share your work as directed by your 
teacher by clicking on the “Share” button, then 
selecting the desired method of sharing.

Share your work

Project Ideas
 • �This project can be used for 

any content to pitch an idea 
or showcase work.

 • �This project can be adapted for 
use with other Adobe products, 
such as Adobe Creative Cloud 
Express.

Select a theme

From the list, select a theme you’d like to use, 
then click “Use this Theme.”

Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Creative kickstarters for any class
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Project Ideas
 • �Have students work in pairs. One 

student will write the claim and 
the other write the counterclaim.

 • �This project can be adapted for 
use with other Adobe products, 
such as Adobe Creative Cloud 
Express.

THINKING ANALYTICALLY WITH

LEARN
Students explore the meaning of claim and counterclaim. They view a 
presentation, and then brainstorm some issues and their associated claim/
counterclaims with a partner. Students record their thinking on a brainstorming 
sheet, and develop at least 5 topics and associated claims/counterclaims.

EVALUATE
Students evaluate their list of topics, claims, and counterclaims, then self-select 
the issue they feel most passionately about. Students engage in research, resulting 
in the writing of a claim and a counterclaim. Students who need extra support 
may use a provided template to scaffold their thinking. After conducting research, 
students write a one-pager explaining their selected claim and counterclaim.

CREATE
Students create an Adobe Portfolio to display their work. They title their Portfolios 
with the name of their topic and choose colors, themes, fonts, and graphics that 
complement and support their arguments.

SHARE
Students share their Adobe Portfolios as instructed.

Use the Menu Bar on the right to add pages 
and change other settings like font, colors, etc.

Customize

Choose a theme

Select a theme you’d like to use for your Portfolio, 
then click “Use this theme.”
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Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

In this project, students create an Adobe Portfolio presenting 
two sides of a self-selected controversial essay. They demonstrate 
their ability to write flexibly, approaching an issue from multiple 
lenses. Because Adobe Portfolio enables students to publish and 
share a personalized, professional-looking website, this strategy 
empowers students to demonstrate their writing and analysis in 
a creative and impactful way.

Creative kickstarters for any class

https://edex.adobe.com/resource/CIAIOL1Cm
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CREATING A FLYER WITH

LEARN
Students select or are assigned a historical figure to research.

RESEARCH
Students start on their historical person’s Wikipedia page and use it as a 
launching-off point to arrive at a variety of cross-referenced sources. Questions 
they will ask as they research include: What significant contributions did this person 
make to our society? What are some interesting quotes that they might have shared 
on social media? What was their role in a historical event? What interesting facts 
would this person share on social media? As they research, they will note their 
sources for citation in a separate document.

CREATE
Students will design three to five social media graphics using Adobe Creative 
Cloud Express. Images should include a photograph, illustration, logo or icon, and 
text. The images will only be viewable for 6 seconds so must be kept short and 
simple. The full project resource, linked below, provides step-by-step guidance 
on designing images and access to a Creative Cloud Express tutorial.

SHARE
Students share their social media graphics as instructed.

2

3

4

As the social media manager for a historical figure, students will 
research facts, quotes, and significant contributions this person 
has made. Then they will design a series of images to make a 
flyer from this person’s perspective.

Add the text for your story and the name of 
your subject. 

Add an image

Project Ideas
 • �Choose historical figures from a 

particular era or event your 
class is studying.

 • �Use famous scientists for a 
science class.

 • �Use famous authors for an 
English class.

Start a new project

Open Creative Cloud Express and choose “Flyer.”

Add the story image that will help to illustrate the story 
of your historical figure by selecting “Add” > “Photo.”

Add text

1

Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Creative kickstarters for any class
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USER EXPERIENCE DESIGN WITH

DO THE RESEARCH
Ask your students to gather information about their project topic. Once they have 
gathered enough details and context, have them start sketching out some ideas for 
how they might represent these facts in a web app.

WHAT’S THE USER JOURNEY?
Adobe XD allows your students to test and design the user’s experience through the 
app or website. Opening XD, you can choose your format with which to start designing 
(e.g., mobile phone type, tablet, or web, and even presentation slides). When in the 
Design Screen, you can set a grid to help plan your layout.

START WIRE-FRAMING
In the left-hand panel, there are three distinct shape tools that can be used to begin 
drawing out the components (such as buttons, banner images, or logo graphics). 
Try drawing out a simple title page with a header, circular start button, and a footer.

CREATE LINKS
To make a new screen view that duplicates the first one (to maintain consistency 
of design, for instance), click on the object label (in this case the name of the phone 
format above the page), hold ALT and drag a new duplicate across. To create a link 
between these states, go to Prototype mode. Click on your start button and drag 
the blue arrow to the next page to connect them.

TEST YOUR DESIGN
Once you have created your workflow through the app or site, you can test your design 
using the mobile or desktop preview buttons at the top right of the interface. Mobile 
previews can be viewed directly on your device so you can test the user experience for 
yourself, or use the Share option to get others to test the design using a bespoke URL.
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In this project, students develop their design thinking and learn 
to create with an outside audience in mind as they build a digital 
experience using modern design and prototyping tools.

UI kits and add-ons

Why re-invent the wheel? XD provides access 
to huge numbers of extra plug-ins, add-ons, and 
pre-created kits that can be downloaded and 
repurposed. These range from Apple iOS icon sets 
and Amazon interfaces to integrating database 
information. XD offers a massive variety of choice.

Components

XD makes it easy to design key elements such as 
buttons or backgrounds, and then convert them 
into components—reusable elements that can be 
dragged into your design from the assets panel. 
These components can be placed in consistent 
layout using the automatic spacing gridlines and 
guides that appear.

Project Ideas
 • �Web pages that teach fellow 

students formulas for math 
classes.

 • �Mobile apps that quiz students 
on verb conjugations for English, 
Spanish, and other language classes.

 • �Simple games that help students 
test their knowledge of the periodic 
table of elements for science classes.

Creative kickstarters for any class

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

http://edex.adobe.com
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CREATING A VIDEO PRESENTATION WITH

LEARN
Students watch a brief video, “What is the internet?,” and then read an article, 
“Ingredients of the internet.”

REFLECT
Students reflect on the role the internet plays in their own life and make a 
list of all the internet-related services, applications, and devices they use on a 
daily basis. This could include computers, smartphones, tablets, and internet-
enabled appliances, along with social media, instant messaging, streaming TV, 
movies, and music, online shopping, and more. They then choose three to five 
entries on their list on which to focus, with particular emphasis on how these 
selections create, mediate, or shape connections between themselves and the 
rest of the world. Students select from a list of prompts to answer in their video. 
These include the internet’s positive and negative effects, screen-time analysis, 
internet culture, the information superhighway, or the student’s own idea.

CREATE
Students open Creative Cloud Express and use their notes to create an “internet 
diary” for themselves, reflecting on role the internet plays in their daily lives.

SHARE
Students share and publish their videos as instructed.

In this project, students create and narrate an Adobe Creative Cloud 
Express video exploring the various ways the internet impacts their 
lives. They engage with computer science while considering the 
answers to this pivotal question. 

Add slides for other aspects of your media. Feel free 
to improvise or experiment with adding additional 
content, images, or narration.

Add a title slide

Add a title slide to your video.

Add other slides

2

3

4

1

Project Ideas
 • �Focus the exercise around a 

theme, such as cyber-bullying 
prevention or connecting with 
people from other cultures.

 • �Have students complete the 
project individually, in pairs,  
or in small groups.

Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Creative kickstarters for any class
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BUILDING MATH APPRECIATION WITH

LEARN
Students view and take notes on a Khan Academy video, “the beauty of algebra.” 
Afterward, they brainstorm examples of how algebra can be applied to scenarios 
in their daily lives.

CREATE
Based on the results of the previous step, students create their own videos in 
Adobe Premiere Rush to help others see the beauty of algebra and observe it 
in our everyday lives. Each video should include an engaging introduction, or 
“hook,” to draw in the audience, examples of algebra in the student’s world, 
and an explanation of how understanding the universal language of math can 
change one’s perspective. 

REFLECT
Students review their work and consider what other content they could 
include in their video to make it more effective, instructive, or engaging. They 
consider whether their language choices are imaginative, memorable, clear, 
and compelling, as well as what tweaks they might make to the design of 
their video to better appeal to their intended audience.

SHARE
Students share and publish their videos as instructed.
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In the lesson, “Narrate your own ‘the beauty of algebra’ video,” 
students consider how math can be used to understand our universe. 
To address this question, students create and narrate a video about 
mathematical patterns they see in the world around them.

Click on “Premiere Rush Soundtracks,” select an 
audio track, and click the “Add” button.

Add audio

Add transitions and overlays

Click on the “Title” tool to add transitions and 
information overlays in your scenes.

Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Project Ideas
 • �Consider how you can 

broaden the topic to include 
other areas of math.

 • �For example, how does 
geometry appear in art 
or nature?

Creative kickstarters for any class

https://edex.adobe.com/resource/5uIrGrtEL
http://edex.adobe.com


19Adobe creative kickstarters for any class Back to Table of Contents

BUILDING PERSUASIVE COMMUNICATION SKILLS WITH

LEARN
Students familiarize themselves with the process of creating an elevator 
pitch, referencing an infographic and a video.

FOCUS
Students choose a company/CEO they want to pitch to and identify the 
value they could bring to that company.

EVALUATE
Students generate ideas and content for each phase of developing an 
elevator pitch using post-its, scrap paper, or a digital solution to address 
each of the five phases of the elevator pitch. Once they have content 
for each phase, they can develop their elevator pitch into a cohesive 
narrative in Adobe Premiere Pro.

CREATE
Students create a 1-minute elevator pitch for the CEO of their favorite 
company. The pitch should be broken up into a minimum of five 
different slides, each slide addressing a phase of the elevator pitch 
process. Students should choose appropriate media to complement 
their pitch.

SHARE
Students share their pitch videos as instructed. 
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Students craft an elevator pitch for a value they could provide 
to a company for that company’s CEO. To facilitate the pitch, 
students use Adobe Premiere Pro to narrate their pitch over a 
series of images or videos that contribute to the pitch theme.

Watch the video on “the perfect pitch.”

The video

The infographic

Study the infographic to understand the five key 
elements of a pitch.5

Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Project Ideas
 • �Focus the pitches on fundraising 

ideas for students’ favorite 
nonprofit or charity.

 • �Have students prepare a pitch 
to a publisher for their favorite 
novel or nonfiction book.

Creative kickstarters for any class
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BUILDING PRESENTATION SKILLS WITH

RESEARCH
Students select a character—real or fictional, literary or historical—from a text 
they’ve recently read. They review the text to identify a few events in their 
character’s life on which they’d like to hear the character’s inner thoughts.

WRITE
Students plan brief (30–45 seconds), confessional-style monologues in the 
voice of their character for one or more events, detailing the character’s 
perspective on the story and the other characters. This stage can be extended 
by asking students to write more monologues, by asking them to write them 
for several characters, or by asking them to collaborate with a partner or group 
to tell a fuller story.

CREATE
Using the front-facing camera on a smart phone, tablet, or computer, students 
film and edit their monologues. Students consider how their chosen setting, 
lighting, and camera angle can contribute to the tone and atmosphere of their 
confessional. Similar to the previous stage, this can be expanded or modified 
in a variety of ways. The full project resource linked below provides guidance 
on using Adobe Premiere Rush, as well as access to tutorials, an example script, 
and confessional.

SHARE
Students share and publish their videos as instructed.
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In “If they had Instagram,” students create a series of short 
confessional-style videos from the perspective of a literary figure. 
Students analyze a text and create a project that helps them 
hone their public speaking skills.

Edit your monologues together, using titles, 
transitions, and filters to structure your project.

Edit

Project Ideas
 • �Use famous historical figures 

and events for a history class—
Sacagawea, Teddy Roosevelt...

 • �Use famous scientists and 
their work for a science class—
Gregor Mendel, Marie Curie...

Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Create

Select the monologues you recorded from 
the “Videos” folder and tap “Create.”

Creative kickstarters for any class
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CREATING A MINI DOCUMENTARY WITH

LEARN
Students begin by selecting a historical event to which they wish to time travel. 
They follow the steps provided in the full resource linked below to identify key 
locations, historical figures, landmarks, and social conditions.

PLAN
Students complete a storyboard using a provided template to plan their in-flight 
video that will play during a time travel trip. Each frame in the template will 
reflect a scene they will create, such as:

	 • Scene 1	—	Welcome guests to the flight on Time Travel Airlines.
	 • Scene 2	—	Let guests know the destination to which they are traveling.
	 • Scene 3	—	Share information from historical figures who lived there.
	 • Scene 4	—	Give guests some information on landmarks they may visit.
	 • Scene 5	—	Inform guests of social conditions they may encounter.
	 • Scene 6	—	Thank guests for joining the flight.

CREATE
Students use their storyboard and research to create their in-flight video. 
The full resource linked below provides guidance and access to a tutorial 
for help on using Premiere Rush.

SHARE
Students share and publish their videos as instructed.
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Students create an in-flight video detailing a historical event to 
which they are time traveling. Because Adobe Premiere Rush 
enables professional video editing, the project empowers 
students to create a documentary-style video.

Click on “Premiere Rush Soundtracks” and select 
an audio track, and click the “Add” button. 

Add audio

Project Ideas
 • �The project can be completed 

individually or by small groups 
of students.

 • �The project can be adapted for 
use with other Adobe products, 
such as Adobe Creative Cloud 
Express.

Create

Select the video clips and images for each scene 
and click “Create”.

Find the sample student project in this resource on the Adobe 
Education Exchange.

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com

Creative kickstarters for any class
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INTERPRETING SOURCE MATERIAL WITH

SOURCE YOUR FOOTAGE
Students can search Creative Commons or Public Domain sites to source relevant 
video footage concerning a topic of study (e.g. social justice, political conflicts, 
historical events, etc.).

CREATE AND RECORD SCRIPT
With source material captured, students can now think about planning their audio 
voiceover as a narration for their video sequence. Students could have a rubric 
specifying topic and assessment criteria (including guidance on audience, length 
of video, etc.) to keep the video documentary focused.

SEQUENCE YOUR FOOTAGE
Open Adobe Premiere Rush and select Create New Project. From here you can 
browse for the footage you will use for your documentary and specify an order to 
sequence it. It doesn’t have to be perfect at this stage and you can always change 
your mind later. Give the project a title and you can begin editing.

EDIT YOUR SEQUENCE
Edit the clips by trimming the video in the timeline or using the editing tools such as 
the Split, Duplicate, and Delete icons next to the video/audio tracks. More advanced 
tools for adjusting speed, color, and applying transitions are accessed by the panels 
on the right hand side of the workspace. Separate music and audio tracks can be 
added into the timeline too!

APPLY GRAPHICS
Budding documentarists can apply professional looking titles and end screens to the 
project with the graphics panel, but the text graphics are also useful for explanatory 
subtitles or adding important elements such as timestamps or extra contextual 
information.
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In this project, students learn to analyze source video footage 
and explain it to others using simple editing techniques.

Track Control

The Layers Panel helps you control and organize 
all of the elements in your document. You can lock, 
hide, and reveal layers by toggling the “eye” icon, 
and you can change the opacity (transparency) of 
each layer using the opacity slider.

Transform Panel

More adventurous documentary-makers can access 
the transform panel to adjust a host of visual options, 
including creating picture-in-picture effects.

TIP: Scaling and cropping options in the Transform 
Panel are useful when using older film clips that may 
have smaller resolution or different aspect ratios.

Project Ideas
 • �Video montages showing aspects 

of a different culture for language 
or social studies classes.

 • �Fictionalized video interviews 
with famous book authors for 
English classes.

 • �Documentaries about public 
health issues for science classes.

Creative kickstarters for any class

Now that you’ve experimented with these examples, find images 
that inspire you and create amazing work for any subject.

For more FREE lesson plans and activities visit edex.adobe.com
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